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Abstract 

Replicating Simple Functions Using MSP430 Value Line MCUs Summary:  

TI has introduced a series of Tech Notes aimed towards realizing simple functions using the MSP430 Value 

Line Sensing family of microcontrollers (MCUs).  By promoting programmability, small package sizes, ultra-

low power characteristics, and aggressive retail prices, these functions showcase the MSP430’s 

adaptability in a wide range of applications where embedded MCUs are not typically considered. 
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What you’ll learn: 
• Understand advantages of MCU adoption 

• 25 Functions   

• Navigate eBook 

• Optimize code for the smallest memory footprint 

• Use resources to develop additional functions 

 
 

 

 



Detailed Agenda 

• 25 Functions  

– Pulse Width Modulation (PWM) 

– Timer 

– System 

– Communications 

• Code Optimization Tips & Tricks 

– IDE settings 

– Efficient coding techniques 

– Live example 
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Value Line Portfolio 

FR20xx 
8KB FRAM 
10-Bit ADC,  
eUSCI_A & eUSCI_B 

FR41xx 
15.5KB FRAM 
10-Bit ADC, eUSCI_A & B 
256 segment LCD driver 

 

FR2310 
2KB FRAM 
10-Bit ADC, eComp 
TIA, OPA(SAC-L1), 
eUSCI_A & B 

FR2110 
2KB FRAM 
10-Bit ADC, eComp 
eUSCI_A 

Sampling Production 

FR2000 
0.5KB FRAM  
eComp, eUSCI_A 

FR2111 
3.75KB FRAM 
10-Bit ADC, eComp 
eUSCI_A 

FR2100 
1KB FRAM 
10-BIT ADC, eComp 

eUSCI_A 

FR2311 
3.75KB FRAM 
10-Bit ADC, eComp 
TIA, OPA(SAC-L1), 
eUSCI_A & B 

FR20xx 
15.5KB FRAM 
10-Bit ADC,  
eUSCI_A & eUSCI_B 

FR41xx 
8KB FRAM 
10-Bit ADC, eUSCI_A & B 
256 segment LCD driver 
 

 
FR41xx 
4KB FRAM 
10-Bit ADC, eUSCI_A & B 
256 segment LCD driver 
 

 

FR2433 - DSBGA 
Up to 16 MHz 
Up to 16KB FRAM 

FR2433 
15.5KB FRAM 
10-Bit ADC, MPY 
2x eUSCI_A, eUSCI_B 
 

FR2422 
7.5KB FRAM 
10-Bit ADC, MPY 
eUSCI_A, eUSCI_B 

16 TSSOP : 5 x 4.4mm 

24 VQFN : 3 x 3mm 

16 TSSOP : 5 x 4.4mm 

20 TSSOP : 6.5 x 4.4mm 

16 VQFN : 4 x 3.5mm 

16 TSSOP : 5 x 4.4mm 

20 VQFN : 4.5 x 3.5mm 

48 TSSOP : 12.5 x 6.1mm 

56 TSSOP : 16 x 6.1mm 

64 LQFP : 10 x 10mm 

48 TSSOP : 12.5 x 6.1mm 

56 TSSOP : 16 x 6.1mm 

64 LQFP : 10 x 10mm 

24 VQFN : 4 x 4mm 

24 DSBGA : 2.3 x 2.25mm 

LCD 

M
E

M
O

R
Y

 

eUSCI_A : UART / SPI 

eUSCI_B : SPI / I2C 

ES: 4Q17 

CS: 2Q18 

RTM: 3Q18 

FR2355 
32KB FRAM 
12-Bit ADC, MPY 
2xeUSCI_A, 
2xeUSCI_B, 
4xSAC-L3(12bit DAC, 
OA, PGA) 
 
 

38 TSSOP : 9.7 x 4.4mm 

40 VQFN : 6 x 6mm 

48 LQFP : 7 x 7mm 

Pin compatible 



MSP430FR2000 

• FRAM: Ultra-low power, universal memory ─ Nearly 

infinite (1015) write cycles, >100x faster than Flash (2MB/s), 

250x less power in writes, flexible as data or program 

memory 

 

Features/Benefits 

MSP430FR2000 
Temperatures -40°C to 85°C 

0.5KB FRAM (with segment 

protections 

for code/data) 

Serial Interface (eUSCI_A) 

Data Protection 

Memory 
MSP430FR2000 

16-bit 

Up to 16 MHz 

Power & Clocking 

Debug 

I/Os 

Timers 

• UART Software Controlled RGB LED Color Mixing 

• Voltage Monitor with Timestamp 

• Single-Slope Analog-to-Digital Conversion Technique 

• UART-to-SPI Bridge 

 

Target Functions 

Analog 

• MSP430Ware  

• Code Composer Studio™ IDE 

• IAR  

 

Software 

1 × Comp with 6-bit DAC 

Embedded Emulation 

Watchdog Timer 

1 × 16 bit TB w/ 3CC Regs 

LFXT  

PMM with BOR, POR, PUC and SVS 

DCO/FLL 

1 × UART + IrDA or SPI 

Up to 12 GPIOs 

Real-time JTAG/SBW 

512B SRAM 

Packages 

Real-Time Clock  

(Counter only) 
TSSOP16  (5*4.4mm) 

QFN24 ( 3*3mm) 

w/ 8 Interrupt & wake up 

VLO 

Bootstrap Loader 

1K ROM CRC16 

Capacitive Touch IO 

REFO 

Tools 

MODOSC 

FR2311 LaunchPad 

      

Target Board 

      



• TI has introduced a series of Tech Notes aimed towards realizing simple functions using the MSP430 

Value Line Sensing family of microcontrollers (MCUs).  These applications are capable of addressing 

the conventional needs of end-equipments across the industrial, personal electronic, and 

telecommunication markets. 

• Several fixed function ICs do not include the flexibility required for a user’s application or might be 

offered at a price too high to be competitively considered in a system design 

• Showcase the MSP430’s ability to replace dedicated ICs in a wide range of applications where 

embedded MCUs are not typically considered  

• Key Components 

– Programmability 

– Small package sizes 

– Ultra-low power 

– Aggressive retail prices 
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Why 25 Functions for 25 Cents? 



Function list for MCUs 
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System Functions 
• EEPROM Emulation 

• Low Power Hex Keypad 

• Single-Slope Analog-to-Digital Conversion Technique 

• Multi-Function Reset Controller 

• Hysteresis Comparator with UART 

• ADC Wake and Transmit on Threshold 

• Tamper Detection 

• Quadrature Encoder Position Counter 

• Programmable Clock Source 

• Programmable Frequency Locked Loop 

 

 

 

 

 

 

PWM Functions 
• UART Software Controlled RGB LED Color Mixing 

• Stepper Motor Control 

• Servo Motor Controller 

• Dual-Output 8-Bit PWM DAC 

• Analog Input to PWM Output  

 

 

 
Timer Functions 
• External RTC with Backup Memory 

• Simple RTC-Based System Wake-Up Controller 

• Programmable System Wake-Up Controller 

• External Programmable Watchdog Timer 

• 7-Segment LED Stopwatch 

 

 

Communications 
• Single-Wire Communication Host  

• UART-to-UART Bridge with Baud Rate Translation 

• UART-to-SPI Bridge 

• SPI I/O Expander 



Pulse Width Modulation (PWM) 
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UART Software Controlled RGB LED Color Mixing 

This simple application uses a low cost MSP430FR2000 device to control Red Green Blue (RGB) LED color mixing.  The 

mixing can be controlled externally by using a UART interface. 

Overview 

Tech Doc Code Example 

Hardware Peripherals 

- Timer_B 

- eUSCI_A (UART mode) 

 

Firmware Footprint 

376 bytes FRAM 

Resources 

12 UART selectable colors available 

9600 baud UART interface 

Performance 

User Interface/HMI Systems 

Applications 

TIDM-G2XXSWRGBLED 

http://www.ti.com/product/MSP430FR2000
http://www.ti.com/lit/pdf/slaa766
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP430-FUNCTION-CODE-EXAMPLES/latest/index_FDS.html
http://www.ti.com/tool/TIDM-G2XXSWRGBLED
http://www.ti.com/tool/TIDM-G2XXSWRGBLED
http://www.ti.com/tool/TIDM-G2XXSWRGBLED
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Stepper Motor Control 

1/16th micro-stepping mode with UART interface controls the frequency from 0  250KHz.  Timer_B of the low cost 

MSP430FR2000 MCU is used to vary the frequency and maintain a 50% duty cycle. 

Overview 

Tech Doc 

Hardware Peripherals 

- Timer_B 

- eUSCI_A (UART mode) 

 

Firmware Footprint 

~250 bytes FRAM 

Resources 

LPM0 used in idle mode with ~300uA 

standby current 

Performance 

Robotics, Industrial Automation, Device 

Positioning 

Applications 

Code Example 

PWM Frequency Modulation 

http://www.ti.com/product/MSP430FR2000
http://www.ti.com/lit/pdf/slaa785
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP430-FUNCTION-CODE-EXAMPLES/latest/index_FDS.html
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Servo Motor Controller 

This implementation uses the low cost MSP430FR2000 device in conjunction with a driver MOSFET to produce a variable 

pulse width of 1  2ms with 16 overall control steps. 

Overview 

Tech Doc 

Hardware Peripherals 

- Timer_B  

- eUSCI_A (UART mode) 

 

Firmware Footprint 

~200 bytes FRAM 

Resources 

16 Steps from 1ms  2ms relating to 0 

 180deg of motion 

Performance 

Robotics, Industrial Automation, Device 

Positioning 

Applications 

Code Example 

Servo Motor Connections and Waveform 

http://www.ti.com/product/MSP430FR2000
http://www.ti.com/lit/pdf/slaa784
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP430-FUNCTION-CODE-EXAMPLES/latest/index_FDS.html
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Dual-Output 8-Bit PWM DAC 

This design shows the implementation of two 8-bit PWM DAC’s using two Timer_B channels using MSP430FR2000 MCU. 

One outputs a 250Hz sine wave and the other outputs a constant DC level. These outputs can be easily modified by adjusting 

lookup table values. 

Overview 

Tech Doc 

Hardware Peripherals 

- Timer_B 

 

Firmware Footprint 

232 bytes FRAM 

Resources 

8-bit, 250Hz Sine Wave Output. 

Performance 

Musical Tuners, Alarms, Toys & Games 

Applications 

Code Example 

http://www.ti.com/product/MSP430FR2000
http://www.ti.com/lit/SLAA804
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP430-FUNCTION-CODE-EXAMPLES/latest/index_FDS.html
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Analog Input to PWM Output Using the Enhanced 
Comparator 

An ADC converts an analog signal, such as voltage or current to a digital number proportional to its magnitude. In the absence 

of an on-chip ADC on the MSP430FR2000 MCU, a low-cost, low-accuracy comparator can be used. Also, in some 

applications, the output must be translated into a pulse width modulated signal. 

Overview 

Tech Doc 

Hardware Peripherals 

- eComp 

- GPIO 

- Timer_B 

Firmware Footprint 

252 bytes FRAM 

Resources 

6 Bit Resolution 

Performance 

DC Electric Motor Control 

Applications 

Code Example 

eCOMP ADC and PWM Diagram 

Analog-to-PWM 

http://www.ti.com/product/MSP430FR2000
http://www.ti.com/lit/SLAA803
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP430-FUNCTION-CODE-EXAMPLES/latest/index_FDS.html


Timer Functions 
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External RTC with Backup Memory 

Based around the low cost MSP430FR2000 MCU, using the POSIX time format, this software RTC implementation offers a 

simple solution for basic real time clock needs. 16 bytes of ultra low power non volatile storage are also provided. 

Overview 

Tech Doc 

Hardware Peripherals 

- RTC Counter 

- eUSCI_A (UART mode) 

 

Firmware Footprint 

376 bytes FRAM 

Resources 

Timestamp is stored in FRAM and is 

updated every second 

Performance 

Fire & Security Systems 

Applications 

Code Example 

RTC and Backup Memory 

http://www.ti.com/product/MSP430FR2000
http://www.ti.com/lit/pdf/slaa767
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP430-FUNCTION-CODE-EXAMPLES/latest/index_FDS.html
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Simple RTC-Based System Wake-Up Controller 

This fixed interval system wake up controller offers <1.5uA operation. Based on the low cost MSP430FR2000 MCU, this 

solution can easily be used to wake up a less energy efficient application processor or wireless interface.  

Overview 

Tech Doc 

Hardware Peripherals 

- RTC Counter 

- GPIO 

 

Firmware Footprint 

246 bytes FRAM 

Resources 

Average power consumption ~1.5uA with 

1 second wake-up time 

Performance 

Wireless Sensor Nodes, Security 

Systems, Battery Powered Meters 

Applications 

Code Example 

Average Power Consumption 

http://www.ti.com/product/MSP430FR2000
http://www.ti.com/lit/SLAA792
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP430-FUNCTION-CODE-EXAMPLES/latest/index_FDS.html
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Programmable System Wake-Up Controller 

This programmable interval wake up controller offers <1.5uA average operation. Based on the low cost MSP430FR2000 MCU, 

the wake up timing can be modified via the SPI interface from an external host processor or other higher power controller. 

Overview 

Tech Doc 

Hardware Peripherals 

- RTC Counter 

- eUSCI_A (SPI mode) 

- GPIO 

 

Firmware Footprint 

364 bytes FRAM 

Resources 

Average power consumption ~1.3uA 

Performance 

Wireless Sensor Nodes, Security 

Systems, Battery Powered Meters 

Applications 

Code Example 

http://www.ti.com/product/MSP430FR2000
http://www.ti.com/lit/pdf/slaa790
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP430-FUNCTION-CODE-EXAMPLES/latest/index_FDS.html
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External Programmable Watchdog Timer 

An external watchdog timer can add an additional level of redundancy to embedded systems.  This low cost MSP430FR2000 

MCU-based implementation allows the user to change the watchdog timer (WDT) period from 1  2s with simple UART 

commands. 

Overview 

Tech Doc 

Hardware Peripherals 

- Timer_B 

- eUSCI_A (UART mode) 

 

Firmware Footprint 

374 bytes FRAM 

Resources 

1 – 2 second WDT timeout period 

200ms steps via UART control 

Performance 

Smoke Detectors, Other Critical Systems 

Applications 

Code Example 

Invalid WDI and Reset 

http://www.ti.com/product/MSP430FR2000
http://www.ti.com/lit/pdf/slaa789
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP430-FUNCTION-CODE-EXAMPLES/latest/index_FDS.html
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7-Segment LED Stopwatch 

Many applications require the need to keep time using simple low-power methods. This implementation demonstrates the 

MSP430FR2000 MCU’s RTC module and outputs a 3 digit timing parameter to an external 3-digit 7 segment LED display. 

Overview 

Tech Doc 

Hardware Peripherals 

- RTC Counter 

- GPIO 

 

Firmware Footprint 

358 bytes FRAM 

Resources 

Counts from 0.1 seconds to 99.9 

seconds and can be scaled to 1 second 

to 999 seconds 

Performance 

Kitchen Appliances, Stopwatch, Time-

keeping Devices 

Applications 

Code Example 

Stopwatch Block Diagram 

Active LED Display 

http://www.ti.com/product/MSP430FR2000
http://www.ti.com/lit/SLAA808
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP430-FUNCTION-CODE-EXAMPLES/latest/index_FDS.html


20 

Voltage Monitor With a Timestamp 

Voltage monitoring is essential for battery and bus powered applications to save the system state through a power loss event. 

Often the real time occurrence should be saved as a timestamp to track the power loss event. The MSP430FR2000 device 

implements these procedures. 

Overview 

Tech Doc 

Hardware Peripherals 

- eComp 

- RTC Counter 

- eUSCI_A (UART mode) 

Firmware Footprint 

368 bytes FRAM 

Resources 

30-mV hysteresis mode to avoid false 

triggers 

Performance 

Data Logging Systems 

Applications 

Code Example 

Write and Read RTC Example 

http://www.ti.com/product/MSP430FR2000
http://www.ti.com/lit/SLAA809
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP430-FUNCTION-CODE-EXAMPLES/latest/index_FDS.html


System Functions 

21 



22 

EEPROM Emulation  

The MSP430FR2000 device can function as a serial EEPROM replacement. Using a small code footprint, the device can 

provide 48 bytes of EEPROM functionality.   

Overview 

Hardware Peripherals 

- eUSCI_A (SPI mode)  

- GPIO 

 

Firmware Footprint 

384 bytes FRAM 

Resources 

20uA @ 3V when in LPM3 mode 

(excluding SPI data transfers) 

Performance 

Tech Doc 

Unit Identification, Backup Information 

Applications 

Code Example 

EEPROM Read Word Sequence 

http://www.ti.com/product/MSP430FR2000
http://www.ti.com/lit/pdf/slaa769
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP430-FUNCTION-CODE-EXAMPLES/latest/index_FDS.html
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Low-Power Hex Keypad 

The MSP430FR2000 device can be implemented in a low power, 16 button keypad system.  

Overview 

Tech Doc 

Hardware Peripherals 

- eUSCI_A (UART mode)  

- Watchdog Timer 

 

Firmware Footprint 

342 bytes FRAM 

Resources 

0.58uA in standby mode waiting for a key 

press 

Performance 

Security Systems, Electronic Smart 

Locks 

Applications 

Code Example 

http://www.ti.com/product/MSP430FR2000
http://www.ti.com/lit/pdf/slaa773
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP430-FUNCTION-CODE-EXAMPLES/latest/index_FDS.html
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Single-Slope Analog-to-Digital Conversion Technique 

A slope converter is an easy way to add ADC functionality to an MCU only featuring a comparator module. This example 

shows a low power, high accuracy implementation based around the MSP430FR2000 device . 

Overview 

Tech Doc 

Hardware Peripherals 

- eComp 

- Timer_B 

 

Firmware Footprint 

384 bytes FRAM 

Resources 

0.03% measurement accuracy of 12K 

resistor @ 75Hz. 

Performance 

Low-Cost Multi-Meters, Thermostats 

Applications 

 

CCR1

Timer_B0

+

-

CAOUT

MSP430FR2000

eCOMP0

CAREF = 

0.25×VCC

DAC

P1.2

P1.0

P1.1 / CA1

Rref

Rsens

Cm

VCC

VCAREF

(0.25×VCC)

Phase I:

CAOUT

Timer value

captured

CAOUT

Timer value

captured

Charge

Rref

Discharge

Phase III:

Charge

Phase IV:

Rsens

Discharge

Phase II:

tref tsens

Code Example 

Voltage at Cm During Resistance 

Measurement 

http://www.ti.com/product/MSP430FR2000
http://www.ti.com/lit/SLAA806
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP430-FUNCTION-CODE-EXAMPLES/latest/index_FDS.html
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Multi-Function Reset Controller 

Host processors may require both a HW reset or a SW reset. The MSP430FR2000 MCU offers a simple solution to address 

both types of resets using a single button.  

Overview 

Tech Doc 

Hardware Peripherals 

- Timer_B 

 

Firmware Footprint 

310 bytes FRAM 

Resources 

Button press <0.5 seconds triggers soft reset 

Button press >1 second triggers hard reset  

Performance 

Computers, Smart Phones 

Applications 

Code Example 

Soft Reset Pulse 

Hard Reset Pulse 

http://www.ti.com/product/MSP430FR2000
http://www.ti.com/lit/SLAA794
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP430-FUNCTION-CODE-EXAMPLES/latest/index_FDS.html
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Hysteresis Comparator with UART 

Comparators are used to differentiate between two different signal levels. Because signal variation at the comparison 

threshold can cause multiple transitions, hysteresis upper and lower limits are applied to minimize the effects of noise. A 

solution can be implemented with the MSP430FR2000 device. 

Overview 

Tech Doc 

Hardware Peripherals 

- eComp 

 

Firmware Footprint 

292 bytes FRAM 

Resources 

7uA with reference voltage of 3.3V 

Performance 

Analog Sensors, Switching Power 

Supplies, Level Detectors 

Applications 

Code Example 

Scope of Input and Hysteresis Comparator 

Output 

Figure 1 

http://www.ti.com/product/MSP430FR2000
http://www.ti.com/lit/SLAA805
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP430-FUNCTION-CODE-EXAMPLES/latest/index_FDS.html
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ADC Wake and Transmit on Threshold 

Many applications require sampling analog signals periodically so action can be taken based on the behavior of those signals. 

ADCs can be triggered with precise timers to provide a solution to this requirement. This design utilizes the MSP430FR2100 

MCU. 

Overview 

Tech Doc 

Hardware Peripherals 

- ADC10 

- eUSCI_A (UART mode), GPIO 

- Timer_B 

Firmware Footprint 

310 bytes FRAM 

Resources 

25uA standby current at 3V 

Performance 

Battery Monitors, Thermostats 

Applications 

Code Example 

Scope of Triangular Input and GPIO Output 

http://www.ti.com/product/msp430fr2100
http://www.ti.com/lit/an/slaa802/slaa802.pdf
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP430-FUNCTION-CODE-EXAMPLES/latest/index_FDS.html
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Tamper Detection 

This design focuses on detecting when a secured enclosure is opened. The described system uses the MSP430FR2000 

device, and provides tamper detection and evidence. This is typically used as the first line of defense in system applications. 

Overview 

Tech Doc 

Hardware Peripherals 

- RTC Counter 

- GPIO 

Firmware Footprint 

< 512 bytes FRAM 

Resources 

Tamper alert detected in <490uS 

Performance 

Utility Meters, Electronic Door Locks, 

Door/Window Sensors 

Applications 

Code Example 

Hardware Connection Diagram Protected Data Erased from FRAM 

Protected Data Stored in FRAM 

http://www.ti.com/product/MSP430FR2000
http://www.ti.com/lit/SLAA813
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP430-FUNCTION-CODE-EXAMPLES/latest/index_FDS.html
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Quadrature Encoder Position Counter 

Quadrature encoders are used to keep track of the angular position of knobs and motors in many applications including 

volume control, robotics and factory automation systems. The MSP430FR2000 device is implemented in this system. 

Overview 

Tech Doc 

Hardware Peripherals 

- eUSCI_A (UART mode) 

- RTC Counter 

 

Firmware Footprint 

< 512 bytes FRAM 

Resources 

Track angular velocity up to 150,000 

RPM 

Performance 

HMI Knobs or Wheels, Robotics 

Applications 

Code Example 

Quadrature Encoder Clockwise 

Rotation Waveforms 

http://www.ti.com/product/MSP430FR2000
http://www.ti.com/lit/SLAA795
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP430-FUNCTION-CODE-EXAMPLES/latest/index_FDS.html
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Programmable Clock Source 

Utilizing the low cost MSP430FR2000 MCU, this clock source provides a UART or SPI selectable frequency output of 1MHz, 

2MHz, 4MHz, 8MHz or 16MHz.  

Overview 

Tech Doc 

Hardware Peripherals 

- eUSCI_A (SPI/UART mode) 

- GPIO 

 

Firmware Footprint 

344 bytes FRAM 

Resources 

Typical power consumption ~400uA @ 

3V operating  at 1 – 16MHz. 

Performance 

Low-frequency RF systems 

Applications 

Code Example 

http://www.ti.com/product/MSP430FR2000
http://www.ti.com/lit/pdf/slaa774
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP430-FUNCTION-CODE-EXAMPLES/latest/index_FDS.html
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Programmable Frequency Locked Loop 

This MSP430FR2100 MCU based variable clock generator utilizes the frequency locked loop to provide an output frequency 

between 0 and 16MHz. The frequency can be controlled by using simple UART or SPI commands.  

Overview 

Tech Doc 

Hardware Peripherals 

- eUSCI_A (SPI/UART mode) 

- GPIO 

 

Firmware Footprint 

872 bytes FRAM 

Resources 

Typical power consumption ~400uA @ 

3V with outputs between 0 – 16MHz. 

Performance 

Low-frequency RF Systems, Modulation 

Transceivers 

Applications 

Code Example 

http://www.ti.com/product/MSP430FR2100
http://www.ti.com/lit/pdf/slaa791
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP430-FUNCTION-CODE-EXAMPLES/latest/index_FDS.html


Communication Functions 
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Single-Wire Communication Host  

Many applications utilize a bi-directional single wire interface to connect to a range of IC’s, such as temperature sensors, gas 

gauges, EEPROM’s etc. This MSP430FR2000 MCU implementation shows how host functionality is achieved under 512 

bytes. 

Overview 

Tech Doc 

Hardware Peripherals 

- GPIO 

 

Firmware Footprint 

384 bytes FRAM 

Resources 

~1.2mA when communicating 

~18uA when idle 

Performance 

Temperature Sensors, Battery Monitors 

Applications 

Code Example 

Figure 1 Single-Wire Reset Pulse, Presence 

Pulse, and ROM Command 

http://www.ti.com/product/MSP430FR2000
http://www.ti.com/lit/pdf/slaa768
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP430-FUNCTION-CODE-EXAMPLES/latest/index_FDS.html
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UART-to-UART Bridge with Baud Rate Translation 

Half Duplex UART to UART bridge designed to interface 2 UART’s operating at different BAUD rates. Based on the low cost 

MSP430FR2000 MCU, this utilizes both a hardware and software UART implementation. 

Overview 

Tech Doc 

Hardware Peripherals 

- Timer_B  

- eUSCI_A (UART mode) 

- GPIO 

Firmware Footprint 

382 bytes FRAM 

Resources 

Hardware UART up to 921600 bps 

Software UART up to 38400 bps 

Performance 

Protocol Converters, Communication 

Speed Bridges 

Applications 

Code Example 

UART-to-UART Bridge Diagram 

http://www.ti.com/product/MSP430FR2000
http://www.ti.com/lit/an/slaa797/slaa797.pdf
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP430-FUNCTION-CODE-EXAMPLES/latest/index_FDS.html
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UART-to-SPI Bridge 

A UART to SPI communication bridge can be a useful function when interfacing two IC’s or systems together.  This example 

implements a HW SPI master and a SW UART interface with the MSP430FR2000 device. 

Overview 

Tech Doc 

Hardware Peripherals 

- eUSCI_A (SPI mode) 

- Timer_B 

 

Firmware Footprint 

376 bytes FRAM 

Resources 

SPI Max : 8MHz bit clock 

UART Max : 38,400 bps BAUD 

Performance 

Protocol Converters 

Applications 

Code Example 

UART-to-SPI Diagram 

http://www.ti.com/product/MSP430FR2000
http://www.ti.com/lit/SLAA796
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP430-FUNCTION-CODE-EXAMPLES/latest/index_FDS.html
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SPI I/O Expander 

I/O expanders can be used to offload low priority tasks such as LED blinking and button monitoring from a host processor.  

This simple implementation with the MSP430FR2000 device shows a SPI to 8-pin GPIO expander.  

Overview 

Tech Doc 

Hardware Peripherals 

- eUSCI_A (SPI mode) 

- GPIO 

 

Firmware Footprint 

360 bytes FRAM 

Resources 

Read Response Time: 0.359ms 

Write Response Time: 0.295ms 

Performance 

Parallel to Serial Converters, I/O 

Expanders, LED Lighting 

Applications 

Code Example 

Master Commands 

SPI I/O Expander Diagram 

http://www.ti.com/product/MSP430FR2000
http://www.ti.com/lit/SLAA807
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP430-FUNCTION-CODE-EXAMPLES/latest/index_FDS.html


Code Optimization 
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Optimization Settings 
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• Accessible in Project > Properties > Build > MSP430 Compiler > Optimization 

• Optimization Level 
• Determines what types of optimizations the compiler can make 

• Register Optimizations 

• Local Optimizations 

• Global Optimizations 

• Inter-procedure Optimizations 

• Whole Program Optimizations 

• Speed vs Size 
• Tells compiler if trade-offs should be made more in favor of size or speed  

• Adjust from 0(size) – 5(speed) 

 

  



Optimizer Assistant 
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• Accessible in View > Optimizer Assistant 

• Allows multiple builds of project with varied optimization settings 

• Option to vary speed vs size trade-offs or optimization level 
• Only 1 build option can be varied at a time (speed vs size or optimization level) 

• The build option not being varied will stay constant at selected setting while the other build option 

is varied 

• Optimizer will display code sizes for different settings 
• Red indicates the code cannot fit in the selected device 

• Yellow indicates the code fits in the device, but there is a better option available 

• Green indicates the recommended option for optimal speed while still fitting into the device 

• Check mark indicates the current selection in the project settings 

  



Code and Data Model 
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• Accessible in Project > Properties > Build > MSP430 Compiler > Processor Options 

• Larger MSP430 devices have code space that extends to addresses of 0x10000 and 

above 
• Extended instruction set is needed to support operations in these 20-bit addresses 

• We should ensure that only the base 16-bit instruction set is used for devices where no 

addresses above 0x10000 exist 

• This is controlled by selecting the correct code and data model in the IDE project settings 
• Select Small Code Memory Model and Small Data Memory Model 

  



Controlling Global Variable Initialization 
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• C-initialization code for global variables may take up more space than directly initializing global 

variables with user code 

• In order to control global variable initialization: 
• Move initialization of global variables into main().  

 

 

 

 

 

 

 

 

 

  

• Disable zero initialization in CCS by navigating to Project > Properties > MSP430Linker > Advanced Options 

> Miscellaneous and set the Zero initialize ELF uninitialized sections to “off” 



Coding Techniques 

42 

• Use Smallest Possible Types for Variables and Constants 
• Use 8-bit types vs. 16-bit types when possible 

• When using the PERSISTENT keyword, use the smallest type of variable possible to minimize 

FRAM space 

• Minimize lookup table values when possible 
• eg: For a PWM lookup table, implement timer dividers to decrease lookup table values 

• Avoid Multiply and Divide 
• Use bit shifts for multiplication or division by powers of 2 

• Utilize lookup tables when possible  

• Use Word Access to CPU Registers  
• Initialize the entire port with one write 

 PAOUT = BIT15 | BIT0;       vs P1OUT = BIT0; P2OUT = BIT7;  

• Write to CPU Registers Only Once (Where Possible) 
 TA0CCTL2 = OUTMOD_4 | CCIE;     vs TA0CCTL2 |= CCIE; 

     TA0CCTL2 &= ~OUTMOD_7; 

     TA0CCTL2 |= OUTMOD_4; 

 Note: when using =, any other bits in register that need to remain set should be written 



Coding Techniques 

43 

• Use intrinsics that will enable compiler to make optimizations during code generation 
• __even_in_range(x,NUM); 

• Tells compiler value x will always be an even value between 0 to NUM inclusive. This information allows the 

compiler to further optimize code than it normally would. 

 

 

 

 

 

 

 

 

 

 

 

 

 

• __low_power_mode_x(void); 
• Enables a low power mode of user’s choice (x) 



Resources 
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• 25 Functions for 25 Cents Blog (Includes Links to TechNotes) 

• eBook (Includes Porting from FR2311 to FR2000 Information) 

• Code Examples 

• Video Series 
 

https://e2e.ti.com/blogs_/b/msp430blog/archive/2017/11/07/25-functions-for-25-cents-an-introduction-to-using-mcus-for-simple-function-enhancement#pi318890=1
https://e2e.ti.com/blogs_/b/msp430blog/archive/2017/11/07/25-functions-for-25-cents-an-introduction-to-using-mcus-for-simple-function-enhancement#pi318890=1
https://e2e.ti.com/blogs_/b/msp430blog/archive/2017/11/07/25-functions-for-25-cents-an-introduction-to-using-mcus-for-simple-function-enhancement#pi318890=1
http://www.ti.com/corp/docs/company/flipbooks/valueline/docs/ValueLine_eBook.pdf?reload=1510072967037
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP430-FUNCTION-CODE-EXAMPLES/latest/index_FDS.html
https://training.ti.com/25-functions-25-cents-video-series


Additional Resources 
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• MSP430 Value Line Sensing 

• MSP430FR4xx_2xx User’s Guide 

• Code Porting From MSP430FR2000 to MSP430FR2311 MCUs 

• Optimizing C Code for Size With MSP430™ MCUs: Tips and Tricks 

• Migrating From the MSP430F2xx and MSP430G2xx Families to the MSP430FR4xx/FR2xx Family 

• How to Use the Integrated Operational Amplifiers on MSP430FR2311  

• VLO calibration on the MSP430FR4xx AND MSP430FR2xx 

• Software I2C master and slave on MSP430FR2111 

• General Oversampling of MSP ADCs for Higher resolution 

• Software UART (C example code is also available) 

• Designing With MSP430™ MCUs and Segment LCDs 

http://www.ti.com/microcontrollers/msp430-ultra-low-power-mcus/msp430frxx-fram/overview/value-line-sensing-mcus.html
http://www.ti.com/lit/ug/slau445g/slau445g.pdf
http://www.ti.com/lit/ug/slau445g/slau445g.pdf
http://www.ti.com/lit/ug/slau445g/slau445g.pdf
http://www.ti.com/lit/ug/slau445g/slau445g.pdf
http://www.ti.com/lit/an/slaa812/slaa812.pdf
http://www.ti.com/lit/an/slaa812/slaa812.pdf
http://www.ti.com/lit/an/slaa801/slaa801.pdf
http://www.ti.com/lit/an/slaa801/slaa801.pdf
http://www.ti.com/lit/an/slaa649d/slaa649d.pdf
http://www.ti.com/lit/an/slaa649d/slaa649d.pdf
http://www.ti.com/lit/an/slaa705/slaa705.pdf
http://www.ti.com/lit/an/slaa705/slaa705.pdf
http://www.ti.com/lit/an/slaa705/slaa705.pdf
http://www.ti.com/lit/an/slaa705/slaa705.pdf
http://www.ti.com/lit/an/slaa693a/slaa693a.pdf
http://www.ti.com/lit/an/slaa693a/slaa693a.pdf
http://www.ti.com/lit/an/slaa693a/slaa693a.pdf
http://www.ti.com/lit/an/slaa693a/slaa693a.pdf
http://www.ti.com/lit/an/slaa693a/slaa693a.pdf
http://www.ti.com/lit/an/slaa714/slaa714.pdf
http://www.ti.com/lit/an/slaa694a/slaa694a.pdf
http://www.ti.com/lit/an/slaa083/slaa083.pdf
http://www.ti.com/lit/an/slaa083/slaa083.pdf
http://www.ti.com/lit/an/slaa654a/slaa654a.pdf
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TI Information – Selective 

Disclosure 


